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    G*Power

     Statistical Power Analyses for Mac and Windows 
    G*Power is a tool to compute statistical power analyses for many different t tests, F tests, χ2 tests, z tests and some exact tests. G*Power can also be used to compute effect sizes and to display graphically the results of power analyses.
 
 
 
    Screenshots (click to enlarge) 
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 Bild vergrößern    Main Window   
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 Bild vergrößern    Main Window (Table)   
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 Bild vergrößern    Power Plot   
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 Bild vergrößern    Power Plot (Table)   
 
 
 
 
    Register 
    Whenever we find a problem with G*Power we provide an update as quickly as we can. We will inform you about updates if you click here and add your e-mail address to our mailing list. We will only use your e-mail address to inform you about updates. We will not use your e-mail address for other purposes. We will not give your e-mail address to anyone else. You can withdraw your e-mail address from the mailing list at any time.
 
 
 
    Help 
    Download the G*Power manual (PDF)
 Download the Short Tutorial of G*Power (PDF) written for G*Power 2 but still useful as an introduction
 For more help, see the papers about G*Power in the References section below.
 
 
 
    References 
    If you use G*Power for your research, then we would appreciate your including one or both of the following references (depending on what is appropriate) to the program in the papers in which you publish your results:
 Faul, F., Erdfelder, E., Lang, A.-G., & Buchner, A. (2007). G*Power 3: A flexible statistical power analysis program for the social, behavioral, and biomedical sciences. Behavior Research Methods, 39, 175-191. Download PDF
 Faul, F., Erdfelder, E., Buchner, A., & Lang, A.-G. (2009). Statistical power analyses using G*Power 3.1: Tests for correlation and regression analyses. Behavior Research Methods, 41, 1149-1160. Download PDF
 
 
 
    Feedback 
    To report possible bugs, difficulties in program handling, and suggestions for future versions of G*Power please .
 
 
 
    Download 
    By downloading G*Power you agree to these terms of use:
	G*Power is free for everyone. This includes people working in commercial environments. However, commercial distribution is prohibited, that is, no-one is allowed to sell G*Power.
	G*Power is distributed from this web page. If you wish to distribute G*Power in some other way, then you need to seek permission from the authors. Please  in which you specify how and for what purpose you intend to distribute G*Power.
	We do not provide licence agreements or other documents beyond those provided on this web page. 
	You may use screenshots of G*Power without asking for permission.
	Considerable effort has been put into program development and evaluation, but there is no warranty whatsoever.

Download G*Power 3.1.9.7 for Windows XP, Vista, 7, 8, 10 and 11 (about 20 MB). Please make sure to choose “unpack with folders” in your unzip tool.
 Download G*Power 3.1.9.6 for Mac OS X 10.7 to 14 (about 2 MB).
 
 
 
    Version History 
    17 March 2020 - Release 3.1.9.7
 Windows
 Changed the behavior of the “X-Y plot for a range of values” which allowed plotting graphs after changing input parameters in the main window without hitting the “Calculate” button which, however, is required to update the “X-Y plot for a range of values” with the new input parameters from the main dialog.
 21 February 2020 - Release 3.1.9.6
 Mac and Windows
 Fixed a bug in z tests: Generic z test: Analysis: Criterion: Compute alpha: The critical z was calculated incorrectly.
 Fixed a bug in t tests: Linear bivariate regression: One group, size of slope: |sy/sx| was sometimes calculated inccorrecty. 
 14 January 2020 - Release 3.1.9.5
 Mac
 Fixed a bug that caused the “Options” button (which is available for some tests in the main window) to disappear when “Hide distributions & control” was selected.
 6 February 2019 - Release 3.1.9.4
 Mac and Windows
 Fixed a bug in t tests: Linear bivariate regression: One group, size of slope. Negative effect directions, that is, slope|H1 < slope|H0, were not always handled correclty. Furthermore, the restriction (|slope| < |sy/sx|) on the effect size, which was previously ignored, is now checked.
 7 July 2017 - Release 3.1.9.3
 Mac
 Fixed a bug that could cause crashes.
 28 March 2014 - Release 3.1.9.2
 Mac
 Fixed a bug in the χ2 tests: Goodness-of-fit tests: Contingency tables module which prevented the computed effect size from appearing in the effect size drawer.
 Windows
 Fixed a bug that could occur under very specific circumstances when transferring an effect size from the effect size drawer to the main window.
 10 March 2014 - Release 3.1.9.1
 Mac
 Now includes the calculator that previously has been included only in the Windows version.
 4 February 2014 - Release 3.1.9
 Mac and Windows
 Fixed a bug in the sign test’s sensitivity analysis which led to an offset of -0.5 in the reported effect size.
 Changed the behaviour of all tests based on the binomial distribution. The upper and lower limits are now always within the range [0,n] instead of [-1,n+1]. This change may lead to alpha values larger than the requested alpha values, but now we have the advantage that the upper and lower limits correspond to actual decision boundaries. For instance, in a two-sided test H0 is rejected if, for the observed number x of successes, it holds that x <= lower limit or x >= upper limit. Note, however, that the change affects the results only when N is very small.
 31 January 2014 - Release 3.1.8
 Mac and Windows
 Improvements in the logistic regression module: (1) improved numerical stability (in particular for lognormal distributed covariates); (2) additional validity checks for input parameters (this applies also to the poisson regression module); (3) in sensitivity analyses the handling of cases in which the power does not increase monotonically with effect size is improved: an additional Actual power output field has been added; a deviation of this actual power value from the one requested on the input side indicates such cases; it is recommended that you check how the power depends on the effect size in the plot window.
 19 April 2013 - Release 3.1.7
 Mac and Windows
 Fixed a problem in the exact test of Proportions: Inequality, two independent groups (uncontional). The problem only occurred when p1 > p2.
 18 Frebruary 2013 - Release 3.1.6
 Mac and Windows
 Fixed a problem in the sensitivity analysis of the logistic regression. The problem only occurred when p2 >= p1.
 Mac
 Fixed a problem in Fisher’s exact test.
 12 September 2012 - Release 3.1.5.1
 Mac
 Fixed a problem with the effect size drawers of ANOVA: Fixed effects. The drawers now appear correctly after clicking on the Determine button.
 20 August 2012 - Release 3.1.5
 Mac and Windows
 Fixed a problem in the test of equality of two variances. The problem did not occur when both sample sizes were identical.
 Fixed a problem in calculating the effect size from variances in the repeated measures ANOVA.
 3 July 2012 - Release 3.1.4
 Mac and Windows
 Added an options dialog to the repeated-measures ANOVA which allows a more flexible specification of effect sizes.
 Fixed a problem in calculating the sample size for Fisher's exact test. The problem did not occur with post hoc analyses.
 22 June 2011 - Release 3.1.3
 Mac and Windows
 Fixed a bug in the ANCOVA module. Changing the number of covariates now correctly leads to the appropriate change in the denominator degrees of freedom.
 5 January 2010 - Release 3.1.2
 Mac and Windows
 Renamed the Repetitions parameter in repeated measures procedures to Number of measurements (Repetitions was misleading because it incorrectly suggested that the first measurement would not be counted).
 Fixed a problem in the sensitivity analysis of the logistic regression procedure: There was an error if Odds ratio was chosen as the effect size. The problem did not occur when the effect size was specified in terms of Two probabilities.
 Mac
 The Window menu now contains the option to hide the distributions plot and the protocol section (Hide distributions & protocol menu item) so that G*Power can be accommodated to small screens. This option has been available for some time in the Windows version (see View menu).
 16 December 2009 - Release 3.1
 Mac
 Added procedures to analyze the power of tests for single correlations based on the tetrachoric model, comparisons of dependent correlations, bivariate linear regression, multiple linear regression based on the random predictor model, logistic regression, and Poisson regression.
 08 December 2009 - Release 3.1.1
 Windows
 Re-enabled options dialog for Correlation: Bivariate normal model.
 29 June 2009 - Release 3.1
 Windows
 Added procedures to analyze the power of tests referring to single correlations based on the tetrachoric model, comparisons of dependent correlations, bivariate linear regression, multiple linear regression based on the random predictor model, logistic regression, and Poisson regression.
 24 January 2008 - Release 3.0.10
 Mac and Windows
 Fixed a problem in the X-Y plot for a range of values for Generic F tests. The degrees of freedom were not properly set in the graph, leading to erroneous plot values.
 22 January 2008 - Release 3.0.9
 Mac
 Eliminated the brushed metal look for better readability under Mac OS X 10.5.
 Windows
 Fixed some minor GUI problems (buttons had German titles; button in file dialog named “open” instead of “save”).
 Fixed problems with distribution plots (plots were sometimes not appropriately clipped when copied or saved as metafile; drawing glitches with some very steep curves).
 The file dialog shown when saving graphs or protocols now uses the user's home directory (myDocuments) as defaults directory.
 10 October 2007 - Release 3.0.8
 Mac and Windows
 Fixed a serious bug in the CDF routine of the noncentral t distribution introduced in the bugfix release 3.0.7. Please update immediately if you installed version 3.0.7.
 8 October 2007 - Release 3.0.7
 Mac and Windows
 Fixed a bug in the function calculating the CDF of the noncentral t-distribution that occasionally led  to (obviously) wrong values when p was very close to 1. All power routines based on the t distribution were affected by this bug.
 14 August 2007 - Release 3.0.6
 Mac
 Fixed a bug in the routine that draws the central and noncentral t distributions for two-tailed tests. When alpha was very small, this bug could cause G*Power to crash.
 03 July 2007 - Release 3.0.5
 Mac and Windows
 Fixed a bug in the Power Plot (opened using the X-Y-plot for a range of values button) for F tests, MANOVA: Global effects and F Tests, MANOVA: Special effects and interactions. Sometimes some of the variables were not correctly set in the plot procedure which led to erroneous values in the graphs and the associated tables.
 26 June 2007 - Release 3.0.4
 Mac and Windows
 Fixed a bug in the Power Plot (opened using the X-Y-plot for a range of values button) for F Tests, Multiple Regression: Special (R2 increase). The numerator df value was not always correctly determined in the plot procedure which led to erroneous values in the graphs and the associated tables.
 Fixed some minor problems with t tests. G•Power now checkes for invalid null effect sizes in a priori analyses. The t distribution PDF routine is now more robust for very large degrees of freedom by explicitly using a normal approximation in these cases.
 When the Power Plot window was first opened by pressing the  X-Y plot for a range of values button, the default was to show 4 plots simultaneously. The default has been changed to 1 plot.
 Corrected some parsing errors in the calculator (in the Mac version, this only concerns text input in normal input fields).
 Corrected a label in the effect size drawer for ANOVA: Fixed effects, omnibus, one-way. In the From variance input mode, the Variance within group field was erroneously labeled Error variance.
 Windows
 Fixed a problem with moving the main window when the effect size drawer is open. Sometimes the mouse pointer appeared to be "glued" to the window and the movement could not be stopped properly.
 1 March 2007 - Release 3.0.3
 Mac and Windows:
 Fixed a bug in the X-Y plots for a range of values for F Tests, ANOVA: Fixed effects, special, main effects and interactions. The df1 value was not always correctly determined in the plot procedure which led to erroneous values in the plots.
 Fixed the problem in the plot procedure that (due to rounding errors) the last point on the x-axis was sometimes not included in the plot.
 28 February 2007 - Release 3.0.2
 Mac and Windows
 Fixed a probem with tooltips for effect size conventions which were not always shown.
 Windows
 Added options mainly intended to make G*Power usable with low resolution displays (800 x 600 pixels)
 The distribution/protocol view and the test/analysis selection view in the main window can be hidden temporarily to save space. To hide/show these sub-views press F4 (plot/protocol) and F5 (test/analysis), respectively, while the main window is active. There are also corresponding entries in the View menu.
 The Graph window can now be made resizable. To do this choose "Resizable Window" in the View menu of the Graph window. Besides enabling (restricted) resizability this option initially shrinks the window to a size that fits into a 800 x 600 screen. Deselecting the option restores the Graph window to the fixed size for which G*Power was optimized.
 Mac
 Fixed a cosmetic problem when drawing “extreme” central and non-central distributions.
 15 January 2007 - Release 3.0.1
 Windows
 Effect size calculation for t Tests, Difference between two indepent means (two groups), case n1 = n2: The wrong means—those of case n1 ≠ n2—were used to calcultate the effect size. This problem has been fixed.
 Minor cosmetic changes.
 New Readme file.
 Updated installation instruction.
 12.01.2007 - First release of version 3.0.0
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